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SECTION I:  GENERAL FORMATTING GUIDELINES 
 
1.1 TITLE PAGE 
 
Every paper submitted to the faculty of the McAfee School of Theology will include a 
Title Page in the proper format (notice the ALL CAPS and the spacing between items): 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.2 PAGE NUMBERING 
 
The Title Page will have no page number, but it will count as "page i." 
 
The Signature Page, Preface, Table of Contents, Introduction, and any other 
Preliminary Pages will be numbered in the bottom center of their pages with lower 
case Roman Numerals, beginning with ii (since the title page is page i). 
 
The Body of the Paper and the Bibliography will be numbered with successive Arabic 
Numerals, beginning with 1.  On the first page of each chapter, the page number will 
appear at the bottom center of the page, and on subsequent pages of each chapter, 
the page number will appear at the upper right hand corner of the page. 
 
 
 
 
 
 
 
 

 
 

McAFEE SCHOOL OF THEOLOGY 

 

 

 

 

 

PAPER TITLE--SINGLE SPACE IF THE TITLE OF THE PAPER EXCEEDS ONE LINE IN 

LENGTH 

 

 

 

A PAPER SUBMITTED TO 

 

NAME OF PROFESSOR(S) 

 

IN PARTIAL FULFILLMENT OF THE REQUIREMENTS FOR 

 

FULL NAME OF COURSE WITH COURSE NUMBER 

 

MASTER OF DIVINITY or DOCTOR OF MINISTRY 

 

 

 

 

 

BY 

 

YOUR NAME 

 

 

 

 

 

ATLANTA, GEORGIA 

 

MONTH YEAR 
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1.2 PAGE NUMBERING 
 
The Title Page will have no page number, but it will count as "page i." 
 
If you include a Table of Contents (see 1.4.7), it will be numbered (and printed on the 
bottom center of the page) as Roman Numeral "ii." 
 
The Body of the Paper and the Bibliography will be numbered with successive Arabic 
Numerals, beginning with 1.   
 
Page 1 will be numbered at the bottom center of the page; all subsequent pages will 
be numbered in the upper right hand corner. 
 

 

DISPLAYING DIFFERENT PAGE NUMBERING FORMAT ON PAGE 1 IF YOU DO NOT 
INCLUDE THE TITLE PAGE IN YOUR DOCUMENT: 
 
In Word 2003: 
1. Place Cursor at beginning of page 1 
 

 choose View 

 choose Header and Footer 

 move Cursor to Footer 

 on Header & Footer Toolbar, select Page Set-up 

 choose Layout 

 choose Different First Page and click OK 

 choose Insert 

 choose Page Number 

 choose Center and click OK 

 close Header & Footer Toolbar 
 
2.  Place Cursor at beginning of page 2 
 

 choose View 

 choose Header and Footer 

 leave Cursor on Header 

 choose Insert 

 choose Page Number 

 choose Right and click OK 

 close Header & Footer Toolbar 
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1.3 MARGINS 
 
Each page of the paper will have a 1" margin on all sides—including the FIRST page of 
the paper and the Bibliography. 
 
Page Numbers must be placed at the 1" margin. 
   

 
 
 
 
 

In Word 2007: 
 

 on the Insert Tab 

 choose Page Number in the Header and Footer box 

 choose Top of Page, Plain Number 3 (right alignment) 

 in the Design tab, choose Different First page in the Options box 

 go to Footer on the First Page of the document 

 on the Insert Tab 

 choose Page Number in the Header and Footer box. 

 choose Bottom of Page, Plain Number 2 (center alignment) 
 
AND ALL SHOULD BE WELL!!!! 

 

To format for a 1" placement of the Page Numbers: 
 
In Word 2003: 

 choose File 

 choose Page Set-Up 

 choose Layout tab 

 under Headers & Footers, From Edge, set to 1" 

 click on OK or Default 
 
In Word 2007: 

 on the Page Layout Tab 

 expand Page Set-Up dialogue box 

 under Headers & Footers, From Edge, set to 1" 

 click on OK or Default 
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1.4 GENERAL FORMATTING ISSUES 
 
1.4.1 All papers will be in 12pt type. 
 
1.4.2 All papers will be double-spaced, with no additional space between 
 paragraphs. 
 

 
 
1.4.3 Paragraphs will be indented .5 inches from the beginning of the 1" margin.   
 
1.4.4 Paragraphs will contain a minimum of three sentences.  The first line of a 
paragraph should not appear alone at the bottom of a page (a "widow"), and the last 
line of a paragraph should not appear alone at the top of a page (an "orphan"). 

 

To format for no additional space between paragraphs: 
 
In Word 2003: 

 Format 

 Paragraph 

 set "Spacing" before and after to 0" 
 
In Word 2007: 

 from the Home Tab 

 expand Paragraph box 

 set "Spacing" before and after to 0"  
 or 

 from Page Layout Tab 

 in Paragraph box 

 set "Spacing" before and after to 0" 

To format for Widow/Orphan Control: 
 
In Word 2003: 

 choose Format 

 choose Paragraph 

 choose the Line and Page Breaks Tab 

 check "Widow/Orphan Control," then OK or Default 
 
In Word 2007: 

 on the Page Layout Tab 

 expand the Paragraph dialogue box 

 choose the Line and Page Breaks Tab 

 check "Widow/Orphan Control," then OK or Default 
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1.4.5 Indented quotes (see below, Section 1.5) will be indented .5 inches from the 
 left margin and single spaced. 
 
1.4.6 Headings will be in the following format: 
 
 If you use three or fewer heading levels, then the format will be: 
 

 First Level  Centered, Important Words Capitalized  

 Second Level  On Left Margin, Italicized, Important Words Capitalized 

 Third Level  Indented .5" from Left margin, Italicized, all lower case.   
   Text will begin directly after the heading. 
 

 If you use four heading levels, then the format will be: 
 

 First Level  Centered, Important Words Capitalized 

 Second Level  Centered, Italicized, Important Words Capitalized 

 Third Level  On Left Margin, Italicized, Important Words Capitalized 

 Fourth Level  Indented .5" from Left margin, Italicized, all lower case.   
   Text will begin directly after the heading. 
 

 Standard Double Spacing before and after heading s. 
 
 
1.4.7 Tables of Contents 
 
If you are writing a paper with section headings, a Table of Contents is very helpful to 
your reader.   
 
The format for Tables of Contents is as follows: 
 
Center title 1" from top margin. 
 
First-level Headings on left margin. 
Second-level Headings .5" indented. 
Third-level Headings 1" indented. 
 
All headings should be typed word-for-word and cap-for-cap as they appear in your 
paper. 
 
Double space between First-level headings; single space between Second- and Third-
level headings. 
 
Add leading dots between heading and page number. 
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If you add a Table of Contents, remember that it is page numbered Roman Numeral "i" 
at the bottom center of the page, and the first written page of your paper is "1," 
bottom center.  See Page Numbering (1.2). 
 
Sample Table of Contents 
 

 
 

 
 
 

TABLE OF CONTENTS 
 

First Level Heading ............................................................................. 1 
 
First Level Heading ............................................................................. 3 
 Second Level Heading .................................................................. 5 
 Second Level Heading .................................................................. 7 
 
First Level Heading ............................................................................. 9 
 Second Level Heading .................................................................. 10 
  Third level heading ............................................................. 12 
  Third level heading ............................................................. 14 
 Second Level Heading .................................................................. 16 
 
First Level Heading ............................................................................. 18 
 
Bibliography  .................................................................................... 25 

Formatting for Leading Dots: 
 
In Word 2007: 
 

 on Ruler Line at top of document 

 Set Tabs at .5" and 1" and at 6" 

 from Home Tab 

 expand Paragraph Box 

 choose Tabs 

 highlight 6" 

 at bottom of box, choose Leader 2 (….) 

 choose set 

 close box 

 to add leading dots in the Table of Contents, press the Tab Key after typing 
the Heading Title 
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1.5 QUOTATIONS 
 
Any quotation of three or more words will be properly footnoted. 
 
Quotations of less than 4 lines will be included in the body of the text and formatted 
with double quote marks. 
 
Quotations of 4 lines or more will be formatted as Block Quotations: 
 

 double spaced below previous text 

 indented .5 inches from the left margin 

 single-spaced  

 NOT marked with double quote marks 

 double spaced above the following text   
 
SOURCES NOT CITED IN THIS MANNER WILL BE VIEWED AS PLAGIARISM AND WILL 
RESULT IN A FAILING GRADE FOR THE PAPER. 

 
 
1.6 QUOTATION MARKS 
 
Use double quote marks when quoting directly from a cited work WITHIN THE BODY 
OF YOUR PAPER (See 1.5 for block quotations). 
 
When "quoting within a quote," use single quote marks. 
 
Double or single quote marks may be used when using special terms such as 'practical 
theology,' or "source theory."  JUST BE CONSISTENT WITHIN THE BODY OF THE PAPER. 
 
Quote marks (double or single) and footnote references will always be placed 
OUTSIDE of Commas and Periods. 
 

 Gunkel states, "Read from beginning to end,"
1
 and this author . . .  

 'practical theology.'
1  

Another school of thought . . . 

 

NOTE: 
 
If you are summarizing or reviewing a book or journal article, you may use 
parenthetical references to refer to the work being summarized or reviewed.  Thus, 
for instance,  you may use the following in a summary of John Barton's "Difficulties in 
the Text." 
 
Barton states that perceptions of errors in the biblical text may be "errors of 
perception by the reader" (p. 10).  
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Quote marks (double and single) and footnote references will always be placed INSIDE 
of Colons and  Semi-Colons. 
 

 'practical theology'
1
; and 

 the end"
1
:  another school of thought . . . 

 

What about Question Marks and Exclamation Points?  If the Question Mark or 
Exclamation Point is part of the quote, then it will be placed INSIDE the Quotation 
Mark.  If not, then it will appear OUTSIDE the Quotation Mark. 
 

 Gunkel asks, "What about the laments in Chronicles?"
1
  Mowinckel states . . . 

 How does Mowinckel analyze Gunkel's genre "laments in Chronicles"?
1
  Most believe . . 

.  

 
1.7 BULLETED AND NUMBERED LISTS: 
 
Bulleted and Numbered lists placed vertically within your text should be off-set from 
the left margin by .5 inches.  Double space between the text and the list, but single 
space within the list.   
 
If the items in the list are complete sentences, begin each with a capital letter and 
include appropriate punctuation (most likely periods).  If the items are not complete 
sentences, then begin each with a lower case letter and no punctuation is  
used. 
 
When the ancient Israelites left Egypt, they 

 

 crossed the Reed Sea 

 grumbled in the wilderness 

 met God at Mt. Sinai 

 traveled to the borders of the Promised Land 

 mourned the death of Miriam 

 

When the ancient Israelites left Egypt, 

 

 They crossed the Reed Sea. 

 God gave them manna and quail when they were hungry. 

 Moses met with God on Mt. Sinai. 

 

When a numbered list in included in the main body of the paper, the list is preceded 
by a colon.  Each number is placed in parenthesis.  If each item within the list has no 
punctuation, then place a comma between the items of the list.  If any item within 
the list contains punctuation, then place a semicolon between the items of the list.   
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When the ancient Israelites left Egypt, they:  (1) crossed the Reed Sea, (2) grumbled in the 

wilderness; (3) met God at Sinai, and (4) mourned the death of Miriam. 

 

When the ancient Israelites left Egypt, they:  (1) crossed the Reed, or Red, Sea; (2) grumbled in 

the wilderness; (3) met God at Sinai, or Horeb; and (4) mourned the death of Miriam. 

  
1.8 ELLIPSES 
 
Any omission of words, phrases, or paragraphs in quoted passages is shown by three 
period dots. 
 
Each period dot will be preceded by a space. 
 
A space will follow the last period dot if a word follows in the original quotation. 
 
Two spaces will follow the last period dot when the elliptical quotation moves from 
one sentence to the next.  If the quotation ends with one sentence and continues in 
the middle of a following sentence or if an entire sentence is omitted, then four 
ellipsis dots are used, with a double space occurring after the first one. 
 
Period dots will always appear INSIDE the Quotation Marks. 
 
The Original Sentences:  "They ministered to their patients with knowing acceptance.  
And the patients appreciated their honest care.  But the pain was always with them." 
 

 O'Connor writes, "They ministered . . . with knowing acceptance."
1
   

 O'Connor writes, "They ministered to their patients . . ."
1
 

 O'Connor writes, "They ministered to their patients . . .  And the patients appreciated their 

honest care."
1
 

 O'Connor writes, "They ministered to their patients with knowing acceptance.  . . . But 

the pain was always with them."
1
   

 

1.9 SCRIPTURE CITATIONS 
 
When referring to a biblical book or to a whole chapter in a book in the main text of 
your paper, spell out the book name.  Note that the current convention is to NOT 
capitalize the word "book." 
 

 In the book of Jeremiah, we read that Jeremiah protests the indifference of the people. 

 In Jeremiah 26, we read that Jeremiah protest the indifference of the people. 

 
When referring to a specific passage from a biblical book in the main text of your 
paper, abbreviate the book name, using the abbreviations listed below—with no 
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period. 
 

 In Jer 26:2-3, we read that Jeremiah protests the indifference of the people. 

 
If, however, the passage being referenced begins the sentence, then spell out the 
book name (General Rule:  Never begin a sentence with an abbreviation). 
 

 Jeremiah 26:2-3 tells us that Jeremiah protests the indifference of the people. 

 

When referring to a chapter or verse(s) of a biblical book in parentheses or in a 
footnote, always abbreviate the name, again with no period. Spell out the book 
name, however, when referring to the entire book. 
 

 In the book of Jeremiah, the prophet protests the indifference of the people of Jerusalem 

(Jer 26; Jer 32; Jer 44:8-12). 

 1 
In Jer 26, we read that the Jeremiah protests the indifference of the people. 

 2
In the book of Jeremiah, we read that the prophet protests the indifference of the people. 

 
But (see above): 
 

 1
Jeremiah 26:4-9 tells us that Jeremiah protests the indifference of the people. 

 
When citing a series of passages from biblical books, whether in the main text of your 
paper or in parentheses or a footnote, place a "comma" between verse references from 
the same chapter and place a "semi-colon" between different chapter or different book 
citations: 
 

 In Jer 34:6, 7, 10; 38:4, 8; Ruth 1:3; and 4:2, we observe . . .  

 The book of Jeremiah contains many complaints against Israel's apostasy (Jer 12:1, 4; 

14:36; 15:5, 7; 16:2). 

 

Punctuation for a sentence that contains a parenthetical biblical reference or page 
number will be in the following format: The Quotation Mark is placed at the end of 
the quotation; the Period is placed at the end of the full sentence (including the 
parenthetical reference). 
 

 "Stephen, full of grace and power, did great wonders and signs among the people" (Acts 

6:8).  

 Barton maintains that there is no one correct way to read the biblical text (p. 65).  
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NOTE:  In chapter and verse citations, either a colon or a period is acceptable.  JUST 
BE CONSISTENT!   

 
 Acts 6:8 or Acts 6.8 

 Gen 12:54 or Gen 12.54 
 
Abbreviations for Biblical Books—always without a period: 
 

Gen 
Exod 
Lev 
Num 
Deut 
Josh 
Judg 
1-2 Sam 
1-2 Kgs 
Isa 
Jer 
Ezek 
Hos 
Joel 
Amos 
Obad 
Jonah 
Mic 

 Nah 
Hab 
Zeph 
Hag 
Zech 
Mal 
Ps (pl.: Pss) 
Job 
Prov 
Ruth 
Cant 
Eccl (or Qoh) 
Lam 
Esth 
Dan 
Ezra 
Neh 
1-2 Chr 

 1-2-3-4 Kgdms 
Add Esth 
Bar 
Bel 
1-2 Esdr 
4 Ezra 
Jdt 
Ep Jer 
1-2-3-4 Macc 
Pr Azar 
Pr Man 
Sir 
Sus 
Tob 
Wis 
Matt 
Mark 
Luke 

 John 
Acts 
Rom 
1-2 Cor 
Gal 
Eph 
Phil 
Col 
1-2 Thess 
1-2 Tim 
Titus 
Phlm 
Heb 
Jas 
1-2 Pet 
1-2-3 John 
Jude 
Rev 

 
 
The following abbreviations may be used, always preceded by Athe,@ and with no 
punctuation. 

 
 
HB 

 
Hebrew Bible 

 
OT 

 
Old Testament 

 
MT 

 
Masoretic Text 

 
QL 

 
Qumran Literature 

 
NT 

 
New Testament 

 
LXX 

 
Septuagint 

 
(O)G 

 
(Old) Greek 

 
VL 

 
Vetus Latina 

 
OL 

 
Old Latin 

 
Vg 

 
Vulgate 
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The following may also be used, always followed by a period: 
 

 
chap(s). 

 
chapter(s) 

 
n(n). 

 
note(s) 

 
col(s). 

 
column(s) 

 
p(p). 

 
page(s) 

 
ep(s). 

 
epistle(s) 

 
pl(s). 

 
plate(s) 

 
frg(s). 

 
fragment(s) 

 
v(v). 

 
verse(s) 

 

 
 
1.10 NUMBERS AND DATES 
 
Spell out all numbers through one hundred and any of the whole numbers followed by 
hundred, thousand, etc. The general rule is:  If you can write the number in two words, then 
spell it out.  If the number appears at the beginning of a sentence, then it always will be 
spelled out. (But references to chapters in biblical books are never spelled out.) 
 

 The words 'ben adam' occur in the book of Ezekiel some seventy-three times. 

 About three thousand years ago, the land of Canaan entered the Iron Age. 

 Of the 150 psalms in the Psalter, over half are attributed to David. 

 In Numbers 1, we read that the descendants of Zebulun numbered 57,400.  

 One hundred seventy-six verses make up Psalm 119.  
 
The rule applies to ordinal numbers as well. 
 

 In the seventy-second occurrence of the words 'ben adam' in the book of Ezekiel . . . 

 On the 125th (122d, 123d) anniversary of Martin Luther's death . . . 

 First Samuel 24 states . . . 
 
The accepted designations for the eras of time are as follows: 
 

Prior to "0‖— BCE  ―before the common era‖ in small caps.   
After "0‖— CE  "common era" in small caps. 
 

NOTE:   
 
To alert your readers which biblical translation or version you are quoting from, footnote 
the first occurrence with a note such as "All scripture citations are from the New Revised 
Standard Version unless otherwise noted." 
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For references to centuries and specific dates, use the guidelines for writing numbers given 
above. 
 

 In the seventh century BCE, the Babylonians . . . 

 In 738 BCE, Esarhaddon . . . 
 
NOTE: Words such as "seventh century,"  "twentieth century," and "twenty-first century" may 

be used as nouns or as adjectives. 
 

 When they are used as nouns, no hyphen is used before the word "century." 

 When they are used as adjectives, a hyphen is used before the word "century." 
 

 In the seventh century BCE, the Babylonians conquered the Assyrians. 

 The seventh-century BCE Babylonians conquered the Assyrians. 

 

 In the twenty-first century CE, Americans . . .  

 In twenty-first-century America, people . . .  

 

AND -- 

 In the mid-seventh century BCE, the Babylonians conquered the Assyrians. 

 The mid-seventh-century BCE Babylonians conquered the Assyrians.  
 
References to decades will be formatted as follows (with no apostrophe): 
 

 In the 1970s, Brevard Childs called for a new approach to reading scripture . . . 

 In the 1380s BCE, Israel was not constituted as a state. 
 

To format small caps: 
 
In Word 2003 

 type characters in lower case 

 highlight the text 

 Format 

 Font 

 select Small Caps 
 
In Word 2007 

 before typing characters 

 from Home Tab 

 in Font Box 

 reduce Font Size by two points 

 type characters in upper case 
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Percentages are to be written as Arabic numbers with the % sign except at the beginning of a 
sentence: 
 

 Gunkel notes that 53% of the psalms in the Psalter are laments. 

 Fifty-three percent of the psalms in the Psalter are laments. 
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SECTION II:  GUIDELINES FOR FOOTNOTES AND BIBLIOGRAPHY 
 
2.1 FOOTNOTE CITATIONS 
 

 will be placed at the conclusion of the body of the text on each page 

 will be separated from the body of the text with a dividing line 

 will be in 12 pt type, just as the body of the paper 

 will begin with an indented superscripted number 

 will be single-spaced within the footnote 

 will have a 10pt space between footnotes (see below) 

 will be numbered consecutively beginning with "1" within each chapter of a multi-
chapter work 

 

TO FORMAT FOOTNOTES: 
 
In Word 2003: 
 
At first Footnote Citation in your Paper: 

 Insert 

 Reference 

 Footnote 

 under Location, choose Below Text from pull-down menu 
 
In the Footnote Text area, before you type anything: 

 Format 

 Styles and Formatting 

 right click on Footnote Text 

 choose Modify 

 in the dialogue box, choose Format, Paragraph 

 in the dialogue box, under Indentation, set Special to First Line by .25" 

 under Line Spacing, choose Single and Set After to 10 pt. 
Make sure that the Font in the Modify Style Window is 12 pt. 

 
In Word 2007: 
 

 choose References  

 choose Insert Footnote in the Footnotes box 

 Right Click in the footnote text area 

 choose Paragraph 

 in the Dialogue Box, under Indentation, set special to First line by .25" 

 under Line Spacing, choose Single and Set After to 10 pt. and click OK 
 
Make sure that the font is 12 pt. 

 Right Click in the footnote text area 

 choose Font 

 check or change Font size and click OK 
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2.2 BIBLIOGRAPHY CITATIONS 

 

 will be placed at the conclusion of the paper 

 will be titled with BIBLIOGRAPHY  (all caps) centered 1" from the top of the page 

 will be formatted as HANGING INDENT 

 will be single spaced within the bibliographic entry 

 will be double spaced between bibliographic entries 

 will be in alphabetical order 
 
The bibliography pages will be numbered continuously with the pages of the paper. 

 

 
 
 
 
2.3 SAMPLE FOOTNOTES AND BIBLIOGRAPHY: 
 

The first footnote reference in a paper or in each chapter of a paper must be a full 
citation of the source. 

 
If the reference immediately following is to exactly the same source, then "Ibid." 
(always with a period) will be used.  Only cite a page number with "Ibid." (always with 
a period AND a comma) if the page referred to is different from the previous footnote. 

 
If a different reference intervenes between two citations of the same source, then a 
shortened citation form may be used for the second reference.  Do not use "op. cit." 

 
 

To Format a Hanging Indent: 
 
In Word 2003: 
 
before you type any Bibliographic Entry 

 Format 

 Paragraph 

 under Indentation, choose Special, then Hanging 

 OK 
 
In Word 2007: 
 
before you type any Bibliographic Entry 

 from the Home Tab 

 expand the Paragraph Dialogue Box 

 under Indentation, choose Special, then Hanging 

 OK 
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2.3.1 When referring to series of page numbers in footnotes and bibliographies, the rules are 
 set based on the FIRST NUMBER in the series: 
 

IF THE FIRST NUMBER IS USE THIS FOR THE 
SECOND NUMBER 

EXAMPLES 

less than 100 use all digits 3-10, 71-72, 96-117 

100 or multiples of 100 use all digits 100-104, 600-698, 1100-1123 

multiples of 100, 
ending with 01-09 

use changed part only, omitting 
unneeded zeros 

107-8, 1002-6, 406-9, 406-49 

multiples of 100, 
ending with 10-99 

use two digits or more to reflect 
changed part 

321-25, 415-532, 1536-38,  

11234-35, 1245-359 

 
2.3.2 City and Publisher Names.   
 

Generally speaking, the city name of the publisher is all that is required in footnote 
and bibliography citations.  If a state name is included (if an informed reader of your 
work might not know the state), use the two-letter postal abbreviation.  If a country 
name is included, spell it out in full.  BUT BE CONSISTENT! 

 
For publisher names, include as much as is necessary to identify the publisher.  Again, 
BE CONSISTENT! 

 
2.3.3 Sample Footnotes and Bibliography: 

 

10 
Mark D. Given, "Restoring the Inheritance in Romans 11:1," Journal of Biblical Literature 118 

(Spring 1999):  90. 

 

 11 
Ibid., 93. 

 

 
12 

Ibid. 

 

 
13 

Nancy L. deClaissé-Walford, The Canonical Shape of the Psalms," in An Introduction to 

Wisdom Literature  and the Psalms:  Festschrift Marvin E. Tate, ed. H. Wayne Ballard, Jr., and W. 

Dennis Tucker, Jr. (Macon:  Mercer University Press, 2000), 98. 
 

 
14 

Jerry Adler, "How the Dinosaurs Lived—And Died," Newsweek Magazine, 27 June 2005, 44. 

 

 
15 

Given, "Romans 11:1," 92. 

 

 
16 

Adler, "Dinosaurs," 46. 

 

 
17 

 Ibid. 
 
 18 

deClaissé-Walford, 99. 

 

 
20

Ibid., 100-103. 
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Sample Bibliography for the above Footnote Citations:   
 
Adler, Jerry.  "How the Dinosaurs Lived—And Died."  Newsweek Magazine, 27 June 2005, 44.52. 

 

deClaissé-Walford, Nancy L.  "The Canonical Shape of the Psalms."  In An Introduction to Wisdom 

Literature and the Psalms:  Festschrift Marvin E. Tate, ed. H. Wayne Ballard, Jr., and W. Dennis 

Tucker, Jr., 93-110.  Macon:  Mercer University Press, 2000. 

 

Givens, Mark D. "Restoring the Inheritance in Romans 11:1."  Journal of Biblical Literature 118 (Spring 

1999):  89-96. 

 
DETAILED INSTRUCTIONS FOR FORMATTING FOOTNOTES AND BIBLIOGRAPHY: 

 
These guidelines provide the information you will need for Footnote and Bibliography 
formatting for the majority of the sources you will consult in writing a paper or thesis.  The 
guidelines do not cover every instance.  See Turabian 7th ed., chapter 17, for information on 
formatting other sources. 
 
 
UNDER EACH NUMBERED DESCRIPTION BELOW, THE FIRST ENTRY IS THE FOOTNOTE FORMAT; 

THE SECOND ENTRY IS THE BIBLIOGRAPHIC FORMAT. 
 
 
2.4 BOOKS WITH ONE AUTHOR: 
 
Footnote: 
 1

 James L. Crenshaw, The Psalms:  An Introduction (Grand Rapids: Wm. B. Eerdmans, 

2001), 6-7. 

 

Bibliography: 
Crenshaw, James L.  The Psalms:  An Introduction.  Grand Rapids:  Wm. B. Eerdmans, 2001. 

 

 
2.5 BOOKS WITH MORE THAN ONE AUTHOR (List all of the names of the authors; do not use 

et al.): 
 
Footnote: 
 

2 
James L. Crenshaw, Marti Steussy, and Norman Gottwald, A History of Israel (Grand 

Rapids: Wm. B. Eerdmans, 2001), 123-24. 

 

Bibliography: 
Crenshaw, James L., Marti Steussy, and Norman Gottwald.  A History of Israel.  Grand Rapids:  

Wm. B. Eerdmans, 2001. 
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2.6 BOOKS EDITIONS OTHER THAN FIRST (rev. ed., 1st ed., 2d ed.,etc): 
 
Footnote: 
 

2 
Bernhard W. Anderson, Out of the Depths:  The Psalms Speak for Us Today, 3d  ed. 

(Louisville: Westminster John Knox Press, 2000), 301-2. 

 

Bibliography: 

Anderson, Bernhard W. Out of the Depths:  The Psalms Speak for Us Today, 3d ed.  Louisville:  

Westminster John Knox Press, 2000. 

 
2.7 BOOKS WITH EDITORS (use this entry format only if you are not referring to a 

specific article in a book with editors): 
 
Footnote: 
 

3
 Steven L. McKenzie and M. Patrick Graham, eds., The Hebrew Bible Today:  An 

Introduction to Critical Issues (Louisville:  Westminster John Knox Press, 1998). 

 

Bibliography: 
McKenzie, Steven L., and M. Patrick Graham, eds.  The Hebrew Bible Today:  An Introduction 

to Critical Issues.  Louisville:  Westminster John Knox Press, 1998. 

 

 
 

2.8 BOOKS WITH TRANSLATORS: 
 
Footnote: 
 

4
 J. P. Fokkelman, Reading Biblical Poetry:  An Introductory Guide, trans. Ineke Smit 

(Louisville:  Westminster John Knox Press, 2001), 97-107. 

 

Bibliography: 
Fokkelman, J. P.  Reading Biblical Poetry:  An Introductory Guide.  Translated by Ineke Smit.  

Louisville:  Westminster John Knox Press, 2001. 

 

 

 

 

 

NOTE: 
 
When do you use "eds." and when do you use "ed."? 
 
When the editors of the book are listed as its authors, as in 2.7 above, then "eds." is 
the appropriate abbreviation. 
 
When the editors of the book are listed after the title of the book to indicated "edited 
by," then "ed." is used, regardless of how many editors are involved. 
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2.9 BOOKS IN SERIES WITH GENERAL TITLES AND EDITORS: 
 
Footnote: 
 4 

James L. Mays, Psalms, Interpretation:  A Bible Commentary for Teaching and 

Preaching, ed. James L. Mays (Louisville:  John Knox Press, 1994), 202-3. 

 

Bibliography: 

Mays, James L.  Psalms.  Interpretation:  A Bible Commentary for Teaching and Preaching, edited by 

James L. Mays. Louisville:  John Knox Press, 1994. 

 
2.10 BOOKS IN SERIES WITH GENERAL TITLES, EDITORS, AND VOLUME NUMBERS: 

 

Footnote: 
 

5 
Marvin E. Tate, Psalms 51-100, Word Biblical Commentary, vol. 20, ed. David A. Hubbard and 

Glenn W. Barker (Dallas:  Word Books, 1990), 5. 

 

Bibliography: 
Tate, Marvin E.  Psalms 51-100.  Word Biblical Commentary, vol. 20, edited by David A. Hubbard and 

Glenn W. Barker.  Dallas:  Word Books, 1990. 

 

2.11 ARTICLES IN BOOKS WITH EDITORS: 
 
Footnote: 
 

6 
Nancy L. deClaissé-Walford, "The Canonical Shape of the Psalms," in An Introduction to 

Wisdom Literature and the Psalms:  Festschrift Marvin E. Tate, ed. H. Wayne Ballard, Jr., and W. Dennis 

Tucker, Jr. (Macon:  Mercer University Press, 2000), 98. 

 

Bibliography: 
deClaissé-Walford, Nancy L.  "The Canonical Shape of the Psalms."  In An Introduction to Wisdom 

Literature and the Psalms:  Festschrift Marvin E. Tate.  Edited by H. Wayne Ballard, Jr., and W. 

Dennis Tucker, Jr., 93-110.  Macon:  Mercer University Press, 2000. 

 

2.12 ARTICLES IN BOOKS WITH GENERAL EDITORS, AND VOLUME NUMBERS: 
 

Footnote: 
 

7 
J. Clinton McCann, Jr., "The Book of Psalms:  Introduction, Commentary, and Reflections," in 

The New Interpreter's Bible:  A Commentary in Twelve Volumes, vol. IV, ed. Leander E. Keck (Nashville:  

Abingdon Press, 1996), 650-52. 

 

Bibliography: 
McCann, J. Clinton, Jr.  "The Book of Psalms:  Introduction, Commentary, and Reflections."  In The New 

Interpreter's Bible: A Commentary in Twelve Volumes, vol. IV, edited by Leander E. Keck, 639-

1280.  Nashville:  Abingdon Press, 1996. 
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2.13 ARTICLES IN BOOKS WITH SERIES TITLES, EDITORS, AND VOLUME NUMBERS: 
 
Footnote: 
 

8 
Patrick D. Miller, "The Beginning of the Psalter," in The Shape and Shaping of the Psalter,  ed. J. 

Clinton McCann, Jr.,  Journal for the Study of the Old Testament Supplement Series, no. 159 (Sheffield:  

JSOT Press, 1993), 84-85. 

 

Bibliography: 

Miller, Patrick D.  "The Beginning of the Psalter."  In The Shape and Shaping of the Psalter. Edited by J. 

Clinton McCann, Jr.  Journal for the Study of the Old Testament Supplement Series, no. 159, 83-

92.  Sheffield:  JSOT Press, 1993. 

 

 

Footnote: 

 
9 

H. F. Fuhs, "יָרֵא," in Theological Dictionary of the Old Testament, vol. VI, ed. G. 

Johannes Botterweck and Helmer Ringgren, trans. David E. Green (Grand Rapids:  Wm. B. Eerdmans, 

1990), 290-315. 

 

Bibliography: 

Fuhs, H. F.  " יָרֵא  ," In Theological Dictionary of the Old Testament, vol. VI, edited by G. Johannes 

Botterweck and Helmer Ringgren.  Translated by David E. Green. 290-315. Grand Rapids:  Wm. 

B. Eerdmans, 1990.  

 
2.14 PRIMARY SOURCE TAKEN FROM A SECONDARY SOURCE 
 
Footnote: 

1Louis Zukofsky, "Sincerity and Objectification," Poetry 37 (February 1931): 269, quoted in 

Bonnie Costello, Marianne Moore: Imaginary Possessions (Cambridge: Harvard Univ. Press, 1981), 78. 
  
Bibliography: 
Zukofsky, Louis. "Sincerity and Objectification." Poetry 37 (February 1931):  269. Quoted 

in Bonnie Costello. Marianne Moore: Imaginary Possessions. Cambridge: Harvard 
Univ. Press, 1981. 

2.15 ARTICLES IN JOURNALS: 
 
Footnote: 
 

10 
Mark D. Given, "Restoring the Inheritance in Romans 11:1," Journal of Biblical Literature 118 

(Spring 1999):  90. 

 

Bibliography: 
Given, Mark D.  "Restoring the Inheritance in Romans 11:1."  Journal of Biblical Literature 118 (Spring 

1999): 89-96. 
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2.16 BOOK REVIEWS IN JOURNALS: 
 
Footnote: 
 

11 
J. Andrew Dearman, review of Joshua:  A Commentary, by Richard D. Nelson, Journal of 

Biblical Literature 118 (Spring 1999): 130-31. 

 

Bibliography: 

Dearman, J. Andrew.  Review of Joshua:  A Commentary, by Richard D. Nelson.  Journal of Biblical 

Literature 118 (Spring 1999): 130-31. 

 
 
2.17 SIGNED ENCYCLOPEDIA AND DICTIONARY ARTICLES (use for Bible Dictionary entries in 

such works as Eerdmans, Mercer, Interpreter's, New Interpreter's, and Anchor): 
 

Footnote: 
13

Michelle Tooley, “Just, Justice,” in Eerdmans Dictionary of the Bible, ed. David Noel Freedman 

(Grand Rapids:  Wm. B. Eerdmans, 2000), 757. 

 

Bibliography: 
Tooley, Michelle.  “Just, Justice.”  In Eerdmans Dictionary of the Bible. Edited by  David Noel 

Freedman, 757-59.  Grand Rapids:  Wm. B. Eerdmans, 2000. 

 

 
2.18 UNSIGNED ENCYCLOPEDIA AND DICTIONARY ARTICLES: 
 
Footnote: 
 9

Columbia Encyclopedia, 6
th

 ed., s.v. “Phoenicians.” 

  

 No Bibliographic Reference is required. 

 

 
2.19 ARTICLES IN MAGAZINES AND NEWSPAPERS: 
 
Footnote: 
 

11 
Jerry Adler, "How the Dinosaurs Lived—And Died,” Newsweek Magazine, 27 June 2005, 44. 

 

Bibliography: 
Adler, Jerry.  “How the Dinosaurs Lived—And Died."  Newsweek Magazine, 27 June 2005, 44-52. 
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2.20 UNPUBLISHED INTERVIEWS: 
 
Footnote: 

 
12 

Dr. Nancy L. deClaissé-Walford, Associate Professor of Old Testament and Biblical Languages, 

interview by author, 8 August 2005, tape recording (transcript, e-mail, etc.), McAfee School of Theology, 

Atlanta. 

 

Bibliography: 
deClaissé-Walford, Nancy L., Associate Professor of Old Testament and Biblical Languages.  Interview 

by author, 8 August 2005.  Tape recording (Transcript, E-mail, etc.).  McAfee School of 

Theology, Atlanta. 

 
 
2.21 THESES OR DISSERTATIONS: 
 
Footnote: 
 

13 
Nancy L. deClaissé-Walford, "Reading from the Beginning; The Shaping of the Hebrew Psalter" 

(Ph.D. diss., Baylor University, 1995), 59-64. 

 

Bibliography: 
deClaissé-Walford, Nancy L.  "Reading from the Beginning:  The Shaping of the Hebrew Psalter."  Ph.D. 

diss., Baylor University, 1995. 

 
2.22 ELECTRONIC SOURCES: 
 
Cite works published on CD- DVD-ROM as you would the analogous printed work. 
 
Journal articles, chapters from books, and books accessed on-line (via ATLA, etc.) should be 
cited as you would the printed work. 
 
Web Sites:  Include as much of the following as possible: 
 

 author 

 title 

 name of internet source 

 complete URL address 

 date accessed 

 

Footnote: 
1
Joel Green, "Bible, Theology and Theological Interpretations," SBL Forum, online:  http://www.sbl-

site.org/Article.aspx?ArticleId=308 (accessed 16 Sept 2004). 

 

Bibliography: 
Green, Joel.  "Bible, Theology and Theological Interpretation."  SBL Forum.  Online:  http://www.sbl-

site.org/Article.aspx?ArticleId=308. (accessed 16 Sept 2004). 
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SECTION III:  GRAMMAR AND STYLE 

 
3.1 FOREIGN WORDS 
 
Foreign words will be represented by italicized type.  Remember that all German nouns are 
capitalized. 
 

 Gunkel attempted to determine the Gattung and Sitz im Leben of each psalm in the Hebrew 

Psalter. 

 Brueggemann maintains that the sine qua non of preaching is the poetic voice. 
 

When citing Hebrew and Greek words, use the Hebrew or Greek character in the body of the 
text and provide a transliteration (and translation if necessary) in parentheses. 
 

 In Lamentations 1, the city-woman calls upon God to יָרָא (—see) the plight of the city. 

 

 
3.2 VERBAL TENSE:  
 
The general rule is:  ―Text is; event was.‖ 
 
When referencing existing written material, use the Present Tense. 
 

 Paul tells us in the book of Romans that humanity is saved by grace. 

 deClaissé-Walford writes that the book of Psalms narrates a story about ancient Israel. 
 
When referencing a past event, use the Past Tense. 
 

 In approximately 1000 BCE, the ancient Israelites established a nation-state in Palestine. 

 deClaissé-Walford wrote in 1995 that the book of Psalms narrates a story about ancient Israel. 

 
When relating the events and actions of a biblical story, you may use either Present Tense or 
Past Tense.  Again, BE CONSISTENT. 
 

 We read in Genesis 12 that God calls Abram and Sarai to journey to the land of Palestine.  With 

little hesitation, they gather their household and set out.  When they arrive at Shechem, God 

appears to them and Abram builds an altar to God. 

or, 

 We read in Genesis 12 that God called Abram and Sarai to journey to the land of Palestine.  With 

little hesitation, they gathered their household and set out.  When they arrived at Shechem, God 

appeared to them and Abram built an altar to God. 
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3.3 CAPITALIZATION: 
 
The convention in writing today is to use a minimum of capitalization.  Whenever you feel 
compelled to capitalize a word, ask yourself "Why?" 
 
Below is a list of words that traditionally been capitalized, but typically are not today. 
 
temple 
postexilic 
preexilic 
gospel 
church 
 of Psalms 
postmodern 

modern 
kingdom 
biblical 
scripture 
scriptural 
sabbath

 
The following words are typically capitalized. 
 
Bible 
Promised Land 
Christian 
Diaspora 
 
But as stated elsewhere, simply BE CONSISTENT! 
 
 
3.4 COMMAS 
 
As with capitalization, use commas only when absolutely necessary.  When you feel the need 
to insert a comma, ask yourself, "Would the reader be able to understand if I did not include a 
comma?" 
 

 In class today we read a short essay by Hermann Gunkel and then compared it with an article 

written by Paul Ricoeur. 

 

 In my Old Testament class, one of the best classes I have ever taken, we discussed Hermann 

Gunkel's methods of Form Criticism. 

 

The comma will be used before the last member of a list (Turabian, 7th ed., 21.2.2). 
 

 In class today, we discussed the methodological approaches of Hermann Gunkel, Brevard Childs, 

and James Sanders. 

 

 



26 

 

 

3.5 GENDER-NEUTRAL LANGUAGE: 
 
Strive for as much gender-neutral language within the body of the text as is possible. 
 
 GOD-LANGUAGE 
 
 Try using a variety of names for God rather than always using the pronoun "he." 
 
 God 
 Lord 
 Yahweh 
 the Sovereign 
 the Creator  
 

HUMAN-LANGUAGE (Gender-neutral language to reference humanity is REQUIRED in all 
papers submitted to the faculty of the McAfee School of Theology.) 

 
It is very important in today's society to strive for gender-neutral language when 
referring to human beings.  A variety of methods can be used.   
 
Below are some passages from Abraham Heschel's seminal work The Prophets, written 
in 1962, before the advent of gender-neutral language.  Following each passage is a 
revision, using gender neutral language whenever possible. 
 

 Prophecy is a reminder that what obtains between God and man is not a contract but a covenant.  

Anterior to the covenant is love, the love of the fathers (Deut 4:37; 10:15).  God's life interacts 

with the life of the people.  Biblical religion is not what man does with his solitariness, but rather 

what man does with God's concern for all men (vol. 2:10). 

 

 Prophecy is a reminder that what obtains between God and humanity is not a contract but a 

covenant.  Anterior to the covenant is love, the love of the ancestors (Deut 4:37; 10:15).  God's life 

interacts with the life of the people.  Biblical religion is not what humanity does with its 

solitariness, but rather what people do with God's concern for all humankind. 

_________________ 

 

 What manner of man is the prophet?  A student of philosophy who turns from the discourses of 

the great metaphysicians to the orations of the prophets may feel as if he were going from the 

realm of the sublime to an area of trivialities.  . . . The prophet is a man who feels fiercely.  God 

has thrust a burden upon his soul, and he is bowed and stunned at man's fierce greed (vol. 1:1, 5).  

 

 What manner of person is the prophet?  Students of philosophy who turn from the discourses of 

the great metaphysicians to the orations of the prophets many feel as if they were going form the 

realm of the sublime to an area of trivialities.  . . . The prophet is a person who feels fiercely.  God 

has thrust a burden upon that one's soul, and the prophet is bowed and stunned at humanity's fierce 

greed. 
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3.6 WHO, THAT, and WHICH: 
 
"Who, "that," and "which" are Relative Pronouns.  They are used to introduce Phrases that 
describe adjacent Nouns. 
 
"Who" is used to introduce a phrase referring to a person or persons.  The phrase is set off 
with commas if it could be omitted from the sentence and the sentence would retain its 
intended meaning. 
 

 The people who lived in southern Mesopotamia were called the Sumerians. 

 The Sumerians, who lived in southern Mesopotamia, are credited with the invention of writing. 
 

"That" is used to introduce a phrase referring to a non-human being or beings.  It is not set off 
with commas. 
 

 The book that tells the story of Gideon is called Judges. 

 

"Which," always set off with commas, is used to introduce a phrase referring to non-human 
being(s) when the phrase could be omitted from the sentence and the sentence would retain 
its intended meaning. 
 

 The epic of Gilgamesh, which is recorded in cuneiform on twelve tablets, relates a Babylonian 

version of the flood story. 

 

 

3.7 WHO and WHOM: 
 
"Who" and "whom" are Pronouns. 
 
"Who" is used as the Subject of a sentence or a phrase. 
 

 Who will read for us? 

 The Sumerians, who lived in southern Mesopotamia, are credited with the invention of writing. 
 

"Whom" is used as the Object of a sentence, a phrase, or a preposition. 
 

 To whom will we read? 

 Whom did you call? 

 The Sumerians, to whom we give credit for the invention of writing, lived in southern 

Mesopotamia. 

 Moses, whom the Jewish people celebrate as the greatest prophet in all Israel, died at the top of 

Mt. Nebo.   
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3.8 SPLIT INFINITIVES 
 
The two parts of an infinitive must always be kept together in a sentence. 
 

 Brueggemann urges us to study carefully the words of the prophets. 

 The Israelites sought to serve the Lord diligently. 
 

 
3.9 CONJUNCTIONS 
 
Most conjunctions, like  "and," "therefore," and " but" are prepositive--that is, they appear at 
the beginnings of sentences and phrases. 
 

 Therefore, the ancient Israelites maintained a covenant relationship with their God. 
 
The conjunction "however," is, however, a postpositive conjunction--that is, it appears as the 
second (or later) word in a sentence or phrase. 
 

 The ancient Israelites, however, maintained a covenant relationship with their God. 

 

 
3.10 ACTIVE VS. PASSIVE VOICE 
 
Use the active voice in writing wherever possible.  Its use minimizes convoluted language and 
does a better job of engaging the reader in what you have written.  Compare the following 
sentences: 
 
Passive: 

 The passage was edited and updated by the Deuteronomistic Historians. 
 

Active: 

 The Deuteronomistic Historians edited and updated the passage. 
 

To correct passive language in your writing, use your word processor's search function to find 
all instances of "by."  
 
3.11 EFFECT and AFFECT 
 
Generally speaking, ―effect‖ is a noun; ―affect‖ is a verb. 
 
The effect of the earthquake was massive destruction. 

 

The earthquake affected the area with massive destruction. 
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3.12 CONTRACTIONS 
 
Generally speaking, contractions are not acceptable in formal writing. 
 
So, “it’s” should never appear in a formal paper.  “It’s” means “it is.”  So if you are tempted to 
write “it’s,” change it to “it is” and see if it makes sense. 
 
“Its,” on the other hand, is the possessive form of “it” and is perfectly acceptable in a formal 
paper. 
 
The same applies to “their” and “they’re.”  “They’re” means “they are.”  So if you are tempted 
to write “they’re,” change it to “they are” and see if it makes sense. 
 
“Their,” on the other hand, is the possessive form of “them” and is perfectly acceptable in a 
formal paper. 
 
 
 
3.13 “THIS” AND “THESE” 
 
When you use “this” or “these” in a sentence, ask yourself the following two questions: 
 
 $ Will my readers know what ―this‖ or ―these‖ refers to? 
 
Scholars have debated the origins of Jer 26:3-5 for centuries since these verses are crucial for 

understanding the message of Jeremiah.    these = Jer 26:3-5 

 

Scholars have debated the origins and various interpretations of Jer 26:3-5 for centuries.  This is a key 

question in the study of the message of Jeremiah.  this = origins, interpretations, Jer 26:3-5???? 

 

 $ Do I need to use ―this‖ or ―these‖ or would ―the‖ do just fine? 
 
Scholars have asked the questions about the origins of the noun forms of Jer 26:3-5 for centuries.  While 

these origins are difficult to determine, scholars have made significant progress in the past twenty years.  

these = would “the” have sufficed? 

 

Scholars have asked the questions about the origins of the noun forms of Jer 26:3-5 for centuries.  While 

the origins are difficult to determine, scholars have made significant progress in the past twenty years.   
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3.14 AVOID UNNECESSARY VERBIAGE 
 
Don’t use a more complicated word or way of stating an idea if a simpler word or way would 
suffice. 
 
Examples: 
 
usage, utilize = use 

 

“In Gen 1:1, it says that . . .” = “Genesis 1:1 says that . . .” 

 

In ancient Mesopotamia, there were many people who worshiped the god Marduk =  

 Many people in ancient Mesopotamia worshiped the god Marduk. 

 

It has been shown in the above survey that the people who are the members of this church . . . 

 The above survey shows that the members of of this church . . . 
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SECTION IV:  ADDITIONAL INSTRUCTIONS FOR PREPARATION OF THESES  
 
 
 
Writers of Theses are to follow the McAfee Style Guide above and are to follow the additional 
instructions given below: 
 
For further questions, consult the Mercer Dissertation/Thesis Format Guide found at 
http://www.mercer.edu/provost/Theses/ThesisRequirementsandGuidelinesrevisedJune2009.
pdf. 
 
 
 
4.1 MARGINS 
 
 All pages are to have 1 ½" margins on the left sides and 1" margins on the right sides 

and bottoms, except: 
 
  
 The first page of the Table of Contents, The Abstract, The Acknowledgements Page, 

each Chapter, the Appendices, and the Bibliography are to have 2" top margins.  All 
other pages are to have 1" top margins. 

 
 
 
4.2 PRELIMINARY PAGES 
 
 Every Thesis must include the following Preliminary Pages (note that some are 

optional) in this order: 
 

 Title Page 

 Copyright Page (if included in Thesis) 

 Approval Page 

 Dedication (if included in Thesis) 

 Acknowledgements 

 Table of Contents 

 List of Tables (if included in Thesis) 

 List of Figures (if included in Thesis) 

 List of Appendices (if included in Thesis) 

 Abstract 
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4.2.1 TITLE PAGE 
 
 The title page format for Theses and Dissertations is as follows: 

 
 
 

 
 

TITLE OF THESIS PROJECT (if more than one line, double space) 
 
 
 
 
 

by 
 
 
 

YOUR FULL NAME 
Credentials (all Degrees:  Degree abbr., Major, University Name, Date Degree awarded; 

Degree abbr. . . , etc.) 
 
 
 
 

A Thesis Submitted to the Faculty 
 

of McAfee School of Theology 
 

in Partial Fulfillment of the  
 

Requirements for the Degree 
 
 
 
 

MASTER OF DIVINITY/ DOCTOR OF MINISTRY 
 
 
 
 

Atlanta, GA 
 

year 
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4.2.2 APPROVAL PAGE 
 
 The Approval Page format for DMin Theses is as follows: 
 
 
 

 
 
 

TITLE OF THESIS PROJECT (if more than one line, double space) 
 
 
 
 
 

by 
 
 
 

YOUR FULL NAME 
 
 

 
 
 
 
 
Approved: 
 
________________________________________________  Date ________________ 
Name of Faculty Supervisor, Thesis Faculty Supervisor 
 
________________________________________________  Date _________________ 
Name of Committee Member, Thesis Committee Member 
 
________________________________________________  Date _________________ 
Name of Committee Member, Thesis Committee Member 
 
________________________________________________  Date _________________ 
Larry L. McSwain, Associate Dean, DMin Studies 
 
________________________________________________ Date __________________ 
R. Alan Culpepper, Dean, McAfee School of Theology 
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The Approval Page format for MDiv Theses is as follows: 
 
 
 

 
 
 
 
 
4.2.3 ACKNOWLEDGEMENTS 
 
 Center Title in all caps 2" from top margin (ACKNOWLEDGEMENTS). 
 
 Triple Space between Title and body of text. 
 
 Double space body of text. 
 

TITLE OF THESIS PROJECT (if more than one line, double space) 
 
 
 
 
 

by 
 
 
 

YOUR FULL NAME 
 
 
 
 
 
 

Approved: 
 
________________________________________________  Date ________________ 
Name of Faculty Supervisor, Thesis Faculty Supervisor 
 
________________________________________________  Date _________________ 
Nancy L. deClaissé-Walford, Academic Track Supervisor 
 
________________________________________________ Date __________________ 
R. Alan Culpepper, Dean, McAfee School of Theology 
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4.2.4 TABLE OF CONTENTS  
 
Sample (all pages numbers are examples only!) 
 

  
 
 
 
 
 
 
 
 
 
 

TABLE OF CONTENTS (centered 2" from top margin) 
 

ACKNOWLEDGEMENTS .......................................................................... v 
 
LIST OF TABLES .................................................................................. vii 
  
LIST OF FIGURES ................................................................................ viii 
 
LIST OF APPENDICES  ........................................................................... ix 
 
ABSTRACT  .................................................................................... x 
 
CHAPTER 
 
 1. CHAPTER TITLE .................................................................. 1 
 
  First Level Subheading ......................................................... 1 
       Title Second Level Subheading ........................................... 4 
            Title Third Level Subheading ......................................... 5 
 
 2. CHAPTER TITLE .................................................................. 25 
 
 etc. for Chapters 
 
APPENDICES  .................................................................................... 65 
 
 A. TITLE OF APPENDIX A .......................................................... 66 
 
 etc. for Appendices 
 
BIBLIOGRAPHY ................................................................................... 75 
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4.2.5 ABSTRACT 
 
 The format for Abstracts for Theses and Dissertations is as follows: 
 

 
 
   
4.3 CHAPTER LAYOUT 
 
 The layout of each chapter will be as follows: 
 
 First Page: 

CHAPTER NUMBER (centered all caps at 2" from top of page) 
 
CHAPTER NAME (centered all caps two spaces below chapter number) 

 
 Chapter pages will be numbered sequentially throughout the Thesis.   
 
 
4.4 FOOTNOTE FORMATTING 
 
 Footnote numbering will begin with #1 at the beginning of each new chapter and each 
 new appendix. 
 
 Complete footnote referencing will begin anew at the beginning of each new chapter 
 and each new appendix. 
  

 
 
 
 
 

 
AUTHOR'S NAME 
Title of Thesis 
(Under the direction of FACULTY SUPERVISOR'S NAME) 
 
triple space 
 
 Paragraph indent and double space the text of the abstract.  The abstract may not 

exceed 350 words. 

 
Thus--treat each new chapter within the thesis as a new "paper," except page 
 number continuously throughout the thesis. 
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4.5 PAGE NUMBERING (page numbers must be 1" from top or bottom of page) 
 
 Page Numbering for the Preliminary Pages will be as follows in Roman Numerals: 
 

 Title Page, no page number, but counts as "page i" 

 Copyright page (if included), no page number, but couts as "page ii" 

 Approval Page, no page number, but counts as "page iii" 

 Beginning with the Dedication page, all Preliminary pages are counted and 
numbered with Roman numerals at the bottom center of the page.  Thus the 
Dedication page will be "iii," and the remaining Preliminary pages will be 
numbered sequentially. 

 
 Page Numbering beginning with Chapter 1 will be as follows in Arabic Numerals: 
 

 The page number of the first page of each chapter, each appendix, and the 
bibliography will be placed at the bottom center of the page. 

 Page numbers for subsequent pages of each section will be placed at the top 
right of the page. 

 
 
4.6 BINDING INSTRUCTIONS 
 
 When  the Thesis has received final approval from the McAfee School of Theology, one 
 copy on regular paper will be sent to the Provost's Office in Macon for approval. 
 
 Upon approval from Macon, the student is to print, on 20 lb., 100% cotton rag, the 
 following numbers of the final thesis: 
 
 For DMin Students: 
 

 1 copy for UMI (microfilm library of theses and dissertations)--$65.00 

 2 copies for the Mercer library--$20.00 

 1 copy for faculty supervisor--$10.00 

 1 copy for DMin Office--$10.00 

 additional copies for the student--$10.00 each 
 
 For MDiv Students: 
 

 2 copies for the Mercer library--$20.00 

  1 copy for faculty supervisor--$10.00 

 additional copies for the student--$10.00 each 
 

Make checks payable to Mercer University and submit to the Bursar's Office. The copies of the 
Thesis, the official Binding Form, and a receipt for fees paid will be sent to Macon, where 
binding is undertaken. 
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